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How can this guide help me? 
This guide provides examples in the MLA style for 
information sources most commonly used by 
DMACC students. It should always be used in 
conjunction with the 8th edition of the MLA 
Handbook and information provided by DMACC 
instructors. You may also want to visit the MLA 
website at http://www.mla.org. Your librarians 
are always ready to help with citation questions. 

Why Do Citation Styles Matter? 
Any academic research project must include 
accurate documentation of the resources 
consulted. This means providing information 
about your sources so your reader can locate them. 
If you examine articles in research journals, you’ll 
notice that they always include a list of references 
with publication information.  

Documentation in research projects has two basic 
features: 

1. Works Cited List: At the end of your paper 
or presentation, include a list of the resources 
you used. The list must be on a separate page 
at the end of your paper with the title “Works 
Cited” centered at the top of the page. Each 
entry, or citation, in the list provides 
information about the individual source. 
Citations are listed in alphabetical order, 
starting with the author’s last name. If a source 
has no author, the entry is alphabetized by 
title. Citations are double-spaced with hanging 
indents. There are specific rules for 
punctuation and italics in a Works Cited list, 
illustrated by the examples in this guide.  

2. In-Text References: Each time you refer to a 
source in the text of your paper, include the 
last name of the author or the first few words 
of the title of the source (enough to identify it 
in your list of Works Cited) and the specific 
page number, if applicable, as near the 
paraphrase or quotation as possible. These 
references lead your reader to the appropriate 
entry in your Works Cited List.  
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 Formatting Your Paper 
Microsoft Word (Desktop) 

What should my final paper look 
like?  
The MLA Style Center recommends that research 
papers adhere to certain formatting guidelines. 

These include: 
 Use 1 inch margins around the text of your paper 

(top, bottom, left, and right). 
 Double-space the entire paper, including 

quotations and the works cited page. 
 Indent the first line of all body paragraphs by 

1/2 inch. 
 Use a basic, readable font such as Times New 

Roman in a standard size (i.e., 12pt). 
 Use only one space after concluding punctuation 

(such as a period). 
 Do not include a title page. Instead, type your 

name, your instructor’s name, the course 
number, and the date at the top of your first 
page, flush with the left margin and double-
spaced. 

 Type the title of your paper above the body of 
the text. Center the title. Do not underline, 
italicize, boldface, type in all capital letters, or 
place in quotation marks. Capitalize all 
important words.  

 Create a header with your last name and page 
number to appear on all pages. (Note: Your 
instructor may ask that you omit the name/page 
number header on the first page.) 

 Print your paper on standard, white 8.5 x 11 inch 
paper. 

How do I format my paper in 
Microsoft Word 2013/2016? 

Open a new Microsoft Word document  

A new document automatically appears when Word 
is opened. 

Create a new blank document  

1. Open Word 2016.  

2. Single-click the Blank document option.  

Shortcut Option: Press <Ctrl> + <N>  in 
Microsoft Word to open a new blank document. 
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 Formatting Your Paper 
Microsoft Word (Desktop) 

Set your margins to 1 inch 
A margin is the empty space between a document’s 
contents and the edges of the page. Word’s default 
margins are 1 inch on each side of the page which is 
also the required margin for MLA.  However, if the 
default is not 1 inch, you can easily adjust the 
margins.  

1. Click the Page Layout tab on the Ribbon and 
click the Margins button in the Page Setup 
group.  
 
A list of common page margins appears.  

2. For 1 inch margins, select the Normal margin 
setting.  
 
The margin setting is applied to the document.  

Note: This is the normal default for margin 
spacing in Word 2016. 

Set your line spacing and 
indentation  
The default settings for 
Word 2013 do not 
match the MLA style 
requirements for line 
spacing and 
indentation, so you will 
need to make the 
following adjustments. 

1. Click the Home tab 
on the Ribbon and click the Line Spacing 
button in the Paragraph group.  

A. Under Special select “First Line” and 
make sure it is set to .5” 

B. Under Spacing, set “After” to 0 pt.  

C. Under Line Spacing, select “Double”. 
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2. Click on Home in the Ribbon and click on the 
Right Align tab.  

3. Click on the green Header & Footer Tool 

Design box at the top of the screen. 

4. Type your last name and press the space bar one 

time.  

5.    Click the Page Number tab. 

6.  

7. Slide your cursor down to Current Position 

Formatting Your Paper 
Microsoft Word (Desktop) 

Create your header 
In MLA style, the name of the author followed by 
the page number should appear at the right top 
margin in the header.   

1. Click the Insert tab on the Ribbon and select 
Header from the Header & Footer group. Scroll 
down to the bottom of the list and select Edit 
Header. 
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and then over to Plain Number. 

8. (OPTIONAL) If your instructor requested that 

you do not include the page number on the first 
page, check the box next to Different First 
Page.  This will remove the page number from 
your first page. 

 

 

8. Press the Close Header and Footer button in 
the ribbon and return to your paper. 

Enter name and course information 

MLA style does not require a separate title page for 
research papers.  Instead, place your name and 
course information in a double-spaced block below 
the header, along the top left-hand margin.  This is 
called a report heading and it should only appear 
on the first page of the document. 

1. Type your name on the first line below the 
header and press Enter. 

2. Type the name of the instructor on the second 
line and press Enter. 

3. Type the course name on the third line and 
press Enter. 

4. Type the date on the fourth line and press Enter.  
MLA style requires the day-month-year                 
(24 September 2014) format.  

Enter the Document Title 

The title of your research paper should appear a 
double space below the name and course 
information, and should be centered between the 
page margins. 

Formatting Your Paper 
Microsoft Word (Desktop) 
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Open your DMACC Webmail.  

Click on the “square” in the corner. (This is usually 
in the upper left-hand corner, but depending upon 
your browser may be in the upper right-hand.)  

 

Formatting Your Paper 
Microsoft Word (Online) 

How do I format my paper in 
Microsoft Word Online? 

What should my final paper look 
like? (https://style.mla.org/)

The MLA Style Center recommends that research 
papers adhere to certain formatting guidelines. 
 
These include: 
 Use 1 inch margins around the text of your paper 

(top, bottom, left, and right). 
 Double-space the entire paper, including 

quotations and the works cited page. 
 Indent the first line of all body paragraphs by 

1/2 inch. 
 Use a basic, readable font such as Times New 

Roman in a standard size (i.e., 12pt). 
 Use only one space after concluding punctuation 

(such as a period). 
 Do not include a title page. Instead, type your 

name, your instructor’s name, the course 
number, and the date at the top of your first 
page, flush with the left margin and double-
spaced. 

 Type the title of your paper above the body of 
the text. Center the title. Do not underline, 
italicize, boldface, type in all capital letters, or 
place in quotation marks. Capitalize all 
important words.  

 Create a header with your last name and page 
number to appear on all pages. (Note: Your 
instructor may ask that you omit the name/page 
number header on the first page.) 

 Print your paper on standard, white 8.5 x 11 inch 
paper. 
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Name your file 

Word Online will automatically save your 
file to your OneDrive account. However, it 
will simply call it “Document”, which is not very 
useful.  

1. Single click on  “File” 

2. Single click on “Save As” 

Formatting Your Paper 
Microsoft Word (Online) 

Single click the tile for Word 

 

 

 

 

 

 

 

 

Single click the New 
Blank Document tile 
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3. Single click on “Save As” 

4. 

Give 
your 
file 

a name 

Formatting Your Paper 
Microsoft Word (Online) 

How do I open a file that already 
exists in Microsoft Word Online? 

Open your DMACC Webmail.  

Click on the “square” in the corner. Single click the 
tile for Word. (See pages 5-6 for illustrations.) 
Either select your document from the “Recent” list 
or click on “Open from OneDrive for Business”.  

 

 

Check “Replace existing file” to 
avoid having multiple files called 
“Document” 



  9  

 Formatting Your Paper 
Microsoft Word (Online) 

Single click on “Edit Document.” Then, 
select “Edit in Browser.” 

Set your line spacing and indentation  

The default settings for Word Online do not 
match the APA style requirements for line spacing 
and indentation, so you will need to make the 
following adjustments. 

1. Your margins will default to 1”. 

2. Click the “Page Layout” tab. 

3. Click the small arrow in the Paragraph 
group. 

4. Set “Spacing” both Before and After to 0.00”. 

5. Change “Line Spacing” to “Double”. 

6. Click “Ok”. 

 

 

Create your header 

In MLA style, the name of the author followed by 
the page number should appear at the right top 
margin in the header.   

1. Click the “Insert” tab and click “Header and 
Footer”.  

2. Click in the right field and enter your last name 
and a space.  

3. Click the Page Numbers button and then 
select the image with the page number in the 
upper right-hand corner. 
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4. Click “Edit in Browser” to close the Header & 
Footer tools and return to your document.  

Enter name and course information 

MLA style does not require a separate title page for 
research papers.  Instead, place your name and 
course information in a double-spaced block below 
the header, along the top left-hand margin.  This is 
called a report heading and it should only appear 
on the first page of the document. 

1. Type your name on the first line below the 
header and press Enter. 

2. Type the name of the instructor on the second 
line and press Enter. 

3. Type the course name on the third line and 
press Enter. 

4. Type the date on the fourth line and press 
Enter.  MLA style requires the day-month-year                 
(24 September 2014) format.  

Enter the Document Title 

The title of your research paper should appear a 
double space below the name and course 
information, and should be centered between the 
page margins. 

Formatting Your Paper 
Microsoft Word (Online) 
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Sample Paper 

Sample Paper  
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In-Text References 

What are in-text references and how do I use them? 
Within the text of your paper, you must show your reader exactly what you borrowed from each source you 
paraphrase or quote, and exactly where in the source you found the material. These are your in-text, or 
parenthetical, references.  

Even if you are including information that you know very well, if a reader (instructor) could ask themselves, 
“How do you know that?” locate and include a citation for the information.  

Your in-text references point to sources in your list of works cited. You should use the primary element of the 
full citation from your Works Cited page. Usually, this will be the author's last name. If the work is listed by 
title, use the title, shortened or in full.  

For a printed source, include the relevant page number or numbers. You may omit page numbers if  citing an 
electronic source without pagination. Keep in-text references brief. They should lead interested readers to 
your Works Cited page for more information without interrupting their flow of reading. If you use the author's 
name in a sentence,  you don't need to repeat it in the parenthetical page citation. Do not include first names, 
titles (Mr., Mrs., Dr., Professor, etc.), the title of the source or other descriptors in your text. While many 
students add these elements in an effort avoid being rude or to be complete, it is incorrect and will be 
penalized. 

Incorrect: in the article, The Intersection of Two Unlikely Worlds: Ratios and Drums, Anthony C. Stevens, 
Janet M. Sharp and Eecky Nelson write…. 

Correct: (Stevens et al 376)  or Stevens et al. (376) write… 

An original passage from the book, The Extreme Searcher’s Internet Handbook (page 20) by Randolph Hock, 
published in 2009 by CyberAge Books is shown on the next page, with examples of different types of in-text 
references. 
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Full citation: 
Hock, Randolph. Extreme Searcher’s Internet 

Handbook. CyberAge, 2009.  

Direct quotation: 
"Knowing about the Deep Web is important 
because it contains a lot of tremendously useful 
information—and it is large. Various estimates put 
the size of the Deep Web at from 200 to 500 times 
the content of the visible web" (Hock 20). 

Paraphrase with the author’s 
name in the text: 
Hock (20) points out that that the Deep Web is 
considerably larger than the visible web.  

Paraphrase with the author’s 
name in the parenthetical 
reference: 
The content of the Deep Web is considerably 
larger than that of the visible web (Hock 20). 

Direct quote with the author’s 
name in the text: 
Hock (20) cites estimates of the Deep Web "at 
from 200 to 500 times the content of the visible 
web.” 

In-Text References 
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In-Text References 

Indirect reference: 
Sometimes, you need to refer to an indirect quotation, that is, something that was itself a quotation in one of 
your sources. In this case, put the abbreviation qtd. in ("quoted in") before the reference. 

Joan London wrote of her father, Jack, “His longing for his daughters was deep and true, his need for them 
was desperate. But did anyone ever bungle more badly in trying to realize that desire? (qtd. in Labor 336). 

This could also be written with both sources listed in the text. 

Labor (336) cites Joan London as saying of her father, Jack, that “his longing for his daughters was deep and 
true, his need for them was desperate”  

You should only include the book, article or Web site that you actually have in your Works 
Cited. In this example, Joan London would not be included in the Works Cited.  

Labor, Earle. Jack London: An American Life. Farrar, Straus & Giroux, 2013. 

Parenthetical reference with 
more than three authors: 
When you are citing or paraphrasing a work with 
more than three authors, you should list the last 
name of the first author, followed by “et al.” and 
the appropriate page number.  
 
All living creatures are made of cells—small 
membrane– bounded compartments filled with a 
concentrated aqueous solution of chemicals 
(Alberts et al. 3). 

Parenthetical reference with no 
author: 
When a source does not include an author, it is 
necessary to refer to it in your text by the full title 
(if short), or the first few words of a longer title. 
Begin with the word by which the source is 
alphabetized in your Works Cited. 

For example, to cite the entry “Plagiarism” from 
Wikipedia in-text, the reference would be:  

“Within academia, plagiarism by students, 
professors, or researchers is considered academic 
dishonesty or academic fraud and offenders are 
subject to academic censure, up to and including 
expulsion” (“Plagiarism”). 
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How do I format my Works Cited page?  
The Works Cited page includes an alphabetical list of the sources you cited in your paper.  You can see 
the Using Citation Tools section of this guide for instructions on how to build a Works Cited page in 
NoodleTools or Microsoft Word. 

The page layout of your Works Cited page uses the same 1 inch margins, double-spacing, and header as 
the body of the paper.  However, the page should be titled Works Cited, and the individual citations will 
use a hanging indent. 

How to create a hanging-indent : 

1. Place your cursor on the first line of a new page, or highlight your citations if they are already typed. 

2. Click the Home tab on the Ribbon and click the Line Spacing button in the Paragraph group.  

3. Click Line Spacing Options.  

4. In the Indentation area, select Hanging by .5” under Special.  Be sure Left is also set to 0” 

5. Press OK. 

Works Cited Page 
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Core Elements  

What are Core Elements? 
With the 8th edition, the MLA Handbook moved 
from a format-based focus to a focus on “core 
elements”. Core elements are those pieces of a 
citation that should be included, regardless of the 
format of the item you located. These include: 
Author, Title of the Source, Title of the 
Container, Other Contributors, Version, Number, 
Publisher, Publication Date, Location, Additional 
Container Information. Elements should be 
listed in this order. An element should be omitted 
if it is not relevant to the format of your work. 
For example, “Version” would not apply to a Web 
site and would be omitted. If your source does 
not provide you the information for a particular 
element, do not include that element in your 
citation. For example, a Web site may not include 
an author. In that instance, you would not 
include the author element, but would begin your 
citation with the title of the source.  

Pseudonyms 
The most common example of a pseudonym is an 
online username, such as those found on 
YouTube. Do not list the author as “Anonymous”, 
but rather list the username as you would a 
traditional name. Example: DMACCUrbanLibrary 
or ALAACRL. 

Author 
The author is the person or group who produced 
the work. This element should end with a period. 
If there is one author, list the last name first with 
a comma, then the first name. Example: Williams, 
Tamara L. If there are two authors, list the first 
author in the manner described, followed by a 
comma the word “and,” then the second author in 
the more traditional first name last name style. 
Example: Williams, Tamara L., and Susan 
Nguyen. If there are three or  more authors, list 
the first author as previously described, followed 
by et al. Example: Williams, Tamara L. et al.  

Editors gather and curate information. As a result, 
they are given descriptive labels. Example: 
Williams, Tamara L., editor. Or , Williams, 
Tamara L., and Susan Nguyen, editors.  

For works written in languages other than 
English and translated, treat the translator as an 
author and include the label, “translator”. 
Example: Williams, Tamara L., and Susan 
Nguyen, translators. 
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Core Elements  

Containers 
MLA employs the concept of “containers”, which 
refers to a larger entity that holds an individual 
work. For example, an article may be contained 
within an academic journal, which may be 
contained within a database. A single item may 
have multiple containers attached to it. 

The title of the container should be italicized. All 
of the words in the title of the container should be 
capitalized, except for conjunctions and 
prepositions. Capitalization and punctuation 
should be adjusted as necessary from the original. 
All of the applicable containers should be 
described. 

Title of the Source 
The title of the source is the title of the article, 
chapter, Web page, etc.  

If the title of the source is part of a larger work, it 
should be placed inside of quotation marks. An 
example, would be an article that was published in 
a magazine or journal, an article from a Web site, 
or a chapter from a book.  

If the source is a single entity, such as a book or an 
entire Web site, it should be italicized.  

In all cases, all of the words of the title, except for 
conjunctions and prepositions, should be 
capitalized. Capitalization and punctuation should 
be adjusted as necessary from the original.  

The alphabetization of an entry is based on a title 
when there is no author listed for the source.  Publication Date 

If multiple dates are provided, use the date that is 
most meaningful or relevant to your use of the 
source. This is usually the most recent date 
provided. If a Web source includes a time as well 
as a date, include that in your citation as well.  
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Publisher 
List the name of the publisher. Omit “The” if it is 
the first word in the Publisher’s name. Omit Co, 
Comp, Corp, Inc, LLC. and Ltd. Abbreviate 
“Press” with “P” and “University” with “U”. For 
example: The Chicago University Press would be 
listed as Chicago UP.  

If the publisher is a division, or subgroup, of a 
larger publisher, list the division or subgroup. 
An example lists Metropolitan Books and on the 
next line says Henry Holt and Company. 
Beneath that it says that Metropolitan is a 
registered trademark of Henry Holt. This 
indicates that Metropolitan is a part of Henry 
Holt. Use Metropolitan in the citation.  

When documenting a film or television 
program, use the name of the company that had 
primary responsibility for the item’s creation. 

The publisher of a Web site can usually be found 
at the bottom of the page, next to the copyright 
declaration.  

The publisher may be omitted in the following 
circumstances: the source is a journal, 
magazine, or newspaper; the author and the 
publisher are the same; a Web site with both the 
same name and publisher (Example: CNN); a 
Web site host that is not involved in producing 
the item (Example: YouTube). 

Version 
Some sources will have a version. Example may 
include Revised, Expanded, Updated, 3rd, or 
director’s cut. The words “Revised” and “Edition” 
are always abbreviated. “ed.” is always listed in 
lower case. Numbered versions should be listed 
with Arabic numbers, such as 2nd ed. or 5th ed. 
Capitalize the first letter of descriptive terms. 
Examples include: Rev. ed. or Updated ed. 
Proper names should be capitalized like titles 
and should not be abbreviated. An example 
would be: New American ed.  

Core Elements  



  19  

 

Location  
Describing a source’s location depends upon the 
format of the source. 

Print. For a print source, provide the page 
numbers using either p. for a single page or pp. 
for multiple pages.  

Web. For Web-based sources, provide the URL 
where the source was found. If a permalink is 
provided, use that in place of the URL in the 
browser address bar. Avoid using shortened 
URLs, such as those from bit.ly or tinyurl. 

Databases. For articles found in the library 
subscription databases, if a DOI is provided, it 
should be used in place of a URL. If no DOI is 
available, use the permalink provided by the 
database. For more information on DOIs, see the 
next page. When citing a doi, use doi: followed by 
the actual code and a period. For example:  

doi:10.1371/journal.pone.0161005. 

A Work of Art or Live Performance Provide 
the name of the place where the item is located 
and its city, unless the city is included in the 
name of the place. Example: Des Moines Art 
Center. (Includes the name of the city, don’t 
repeat “Des Moines”.) Or, Science Center of 
Iowa, Des Moines. (Provide the city name after 
the name of the place.) Or, Wells Fargo Area, Des 
Moines. A lecture or live address, may include 
the  descriptor Address. or Lecture. at the end of 
entry.  

Optional Elements  
There are several optional elements that may be 
added to your entry either upon your instructor’s 
request or to add clarity to your entry. 

Date of Original Publication. If your source is 
a republication of an earlier work, add the original 
date of publication immediately following the 
source’s title which is followed by a period. (This 
is different from a work with multiple copyright 
dates. This refers to a work that went out of print 
and then was republished at a later time.)  

City of Publication. Unless you are using a copy 
of a book published before 1900, or a copy 
obtained in a country other than a United States, 
this element should not be included unless 
specifically requested by your instructor. 

Multivolume Work. If your source is part of a 
multivolume work, such as part of a multibook 
set, you should include the volume number and 
the total number of volumes. 

Series. If your source is part of a series, you may 

Core Elements  

include the name of the series at the end of the 
entry. It should be neither italicized nor in 
quotation marks.  

Date of Access. Since online sources often 
change or can be removed, it is sometimes helpful 
to include a date of access at the end of the entry. 
This is especially true if the source does not 
include a publication date. It should be written in 
a European style with the date month year, with 
no italics or quotation marks. Example: 14 
February 2017.  
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What is a DOI?  
DOI stands for Digital Object Identifier. It is a string of numbers and letters that serve as a permanent 
“address” to digital objects such as journal articles. URLs (web addresses) are constantly changing, and are, 
therefore, not a particularly effective way to relocate digital information. Since DOIs never change, they 
should always lead users back to the original document. Using a DOI instead of a URL in a reference list 
prevents users from encountering broken links and dead ends when recovering sources from a Works Cited 
page. 

DOI is administered by the International DOI Foundation. Individual documents (articles and sometimes 
books) are assigned DOIs by the publisher at the time of publication. Once assigned, they will never change. A 
DOI will link readers directly to the object in question (or information about how to access the object) no 
matter where the object currently resides or how many times it has been moved. DOIs are also independent of 
database vendors, meaning that if an individual article or journal is indexed in multiple databases, it can be 
retrieved in all of them using the same DOI. 

CrossRef.org is a website that helps researchers and students check existing and locate missing DOIs. Use 
their website (www.crossref.org) to look up a DOI for an article, to verify an article’s DOI, or to find an article 
using its DOI.  

DOI takes the place of changeable resource information (such as URLs or database information). It also 
eliminates the need for retrieval dates. Use DOI information whenever available, both for electronic resources 
and print resources.  

If you have questions about DOIs, or what to do if your source does not include this information, you may 
contact a DMACC librarian for assistance.  

DOI 
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Sample Works Cited List 
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Examples: Books 

A book with one author or 
editor 

Weimer, Maryellen. Learner-Centered Teaching: 

Five Key Changes to Practice. Jossey-

Bass, 2002. 

Wallin, Desna L., editor. Adjunct Faculty in 

Community Colleges: An Academic 

Administrator's Guide to Recruiting, 

Supporting, and Retaining Great 

Teachers. Anker, 2005. 

A book with two authors or 
editors 

Devine, Jane, and Francine Egger-Sider. Going 

Beyond Google Again: Strategies for 

Using and Teaching the Invisible Web. 

Neal-Schuman, 2014.  

A book with three or more 
authors or editors 

Aquilar, Linda S., et al. The Community College: 

A New Beginning. Kendall Hunt, 2005.  

Note: "et al." means "and others"  

A book with a corporate author 

American Association of Community Colleges. 

State-by-State Profile of Community 

Colleges. Community College, 2003. 

A multivolume work 

English, Fenwick W., editor. Encyclopedia of 

Educational Leadership and 

Administration. Sage, 2006. 2 vols. 

De Vos, Gail. "Casper the Friendly Ghost." Comics 

Through Time: A History of Icons, Idols 

and Ideas, edited by M. Keith Booker, vol. 

1, 1800-1960, Greenwood, 2014, pp. 61-63.  
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Examples: Books 

An edition or version a book 

Vaughan, George B. The Community College 

Story. 3rd ed., American Association of 

Community Colleges, 2006. 

A chapter or section of a book 
Carter, Elizabeth, and Renee N. Jefferson. 

"Collaborating on Information Literacy." 

Revisiting Outcomes Assessment in 

Higher Education, edited by Peter Hernon 

et al., Libraries Unlimited, 2006, pp. 302-

26. 

A book found through Google 
Books 

Roueche, John E., et al. The Creative Community 

College: Leading Change Through 

Innovation. American Association of 

Community Colleges, 2010. Google Books, 

books.google.com/books?

id=Yn2GoAEACAAJ&dq=creative+comm

unity+college&hl=en&sa=X&ved=0ahUK

Ewi1nZffxJDSAhWljFQKHbfAD7gQ6AEI

HDAA. Accessed 26 Feb. 2017. 



Updated: 3/17 24 

 

More than one chapter or 
section of a book 

Note: List each essay separately, followed by a 
cross-reference to the book (the editor's name 
and the page numbers).  List the book itself in a 
separate entry, with complete publication 
information. 
 
Nielsen, Norm. "A History of Entrepreneurship at 

Kirkwood Community College." Roueche 

and Jones, pp. 81-92. 

Roueche, John E., and Barbara R. Jones, editors. 

The Entrepreneurial Community College. 

Community College, 2005.  

Valek, Millicent. "Entrepreneurial Risk Taking." 

Roueche and Jones, pp. 135-142.  

 

Cross-References  
If you are citing two or more entries/chapters from 
a single source, such as a book where each chapter 
has a different author (anthology), create an entry 
for the entire work. In the example above, this is 
the entry that begins with Roueche. Then, create 
“cross-reference” entries for individual works 
within that larger source. The “cross-reference” 
entry should begin with the name of the author of 
the individual piece, the title of the individual 
work in quotation marks, a reference to the author
(s)/editor(s) of the larger work, and the inclusive 
page numbers. In the example above, the entries 
for both Nielsen and Valek are cross-reference 
entries.  

Examples: Books 
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Wikipedia 

"Community College." Wikipedia, 22 Jan. 2017, 

en.wikipedia.org/wiki/

Community_college. Accessed 4 Mar. 

2017. 

An encyclopedia entry 

Stump, David. "Paradigm." New Dictionary of the 

History of the Ideas, edited by Maryanne 

Cline Horowitz, vol. 4, Thomson Gale, 

2005, pp. 1714-18.  

Credo Reference database 

"Quilting." The Columbia Encyclopedia, Credo 

Reference, 2016, 

search.credoreference.com/content/topic/

quilting. Accessed 4 Mar. 2017.  

An online dictionary or 
encyclopedia 

Chirka, E. M. "Bochner-Martinelli Representation 

Formula." Encyclopedia of Mathematics, 

Springer/European Mathematical Society, 

12 Mar. 2012, 

www.encyclopediaofmath.org/index.php/

Bochner-Martinelli_representation_ 

formula. Accessed 27 Feb. 2017. 

"Jack London." Holocaust Encyclopedia. United 

States Holocaust Memorial Museum, 

www.ushmm.org/wlc/en/article.php?

ModuleId=10008068. Accessed 28 Feb. 

2017. 

Examples: Reference Sources 

An encyclopedia entry 

Stump, David. "Paradigm." New Dictionary of 

the History of the Ideas, edited by 

Maryanne Cline Horowitz, vol. 4, 

Thomson Gale, 2005, pp. 1714-18.  
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Examples: Articles 

Scholarly versus popular:  
What’s the difference? 
Traditional popular materials include newspapers 
and magazines, such as The New York Times or 
Newsweek magazine. While these publications 
serve a very important purpose, instructors will 
often require students to use scholarly resources 
for their research projects. Journals are the most 
common place to find scholarly information. They 
include articles written by experts that are often 
reviewed and critiqued by other experts before 
they can be published.  Because of this review by 
other experts in the field, it is common to hear the 
term “peer reviewed” in regards to scholarly 
publications.  

What is a periodical? 
A periodical is any publication that appears on a 
regular basis, such as a daily newspaper, a weekly 
or monthly popular magazine, or a scholarly 
journal published three or four times a year. 
Articles from periodicals are excellent resources 
for student research projects.  

Is it a magazine, a journal, or a 
reference book? 
The DMACC databases provide information from 
a variety of sources, including magazines, journals 
and reference books. It’s important to distinguish 
which type of resource you are using.  

Books will often include words like Encyclopedia, 
Dictionary or Survey in the title. A publisher is 
almost always provided. Many times you may see 
an “ISBN”, which is a code for the book. You may 
see phrases like, “In The Encyclopedia of…” 

Magazines and journal articles will not list a 
publisher. They will list a “source”, which is the 
name of the magazine/journal. It will include a 
date of publication, which is usually listed as a 
month and year (April 2017). Generally, you will 
also see a volume and issue, which may be 
identified, or may look like a decimal number 
(132.7).  Many articles also include a DOI. See 
page 21 of this handout for more information on 
DOIs and how they are used in MLA. 
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An article from a magazine 
(print) 
Pontzer, Herman. "The Exercise Paradox." 

Scientific American, vol. 36, no. 2, Feb. 

2017, pp. 26-31. 

A newspaper article (Print) 
Pfannenstiel, Brianne. "Lawmakers Given an 

Earful: Statehouse Packed for Public 

Hearing on Collective Bargaining Laws." 

Des Moines Register, Metro ed., 14 Feb. 

2017, sec. 1, p. 1+. 

Note: Omit beginning articles for newspaper 
titles. (Example: The Des Moines Register 
becomes Des Moines Register) 

An article in a scholarly 
research journal? (print) 
Roberts, Brent W., et al. "A Systematic Review of 

Personality Trait Change through 

Intervention." Psychological Bulletin, vol. 

143, no. 2, Feb. 2017, pp. 117-41. 

An article from online journal 
Catalano, Amy Jo, and Sharon Rose Phillips. 

"Information Literacy and Retention: A 

Case Study of the Value of the Library." 

Evidence Based Library and Information 

Practice, vol. 11, no. 4, 2016, 

doi:/10.184381B82K7W. Accessed 27 Feb. 

2017. 

Cowell, Amanda E. "Social Media at the College of 

New Jersey Library." In the Library with 

the Lead Pipe, Feb. 2017, 

www.inthelibrarywiththeleadpipe.org/ 

2017/social-media-tcnj/. Accessed 27 Feb. 

2017. 

Examples: Articles 

An article from a magazine 
(web) 
Lukianoff, Greg, and Jonathan Haidt. "The 

Coddling of the American Mind." Atlantic, 

Sept. 2015, www.theatlantic.com/

magazine/archive/2015/09/the-coddling-

of-the-american-mind/399356/. Accessed 

3 Mar. 2017.  
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Examples: Articles 

An article from a database  
Padgett, Lauree. "Filtering Out Fake News: It All 

Starts With Media Literacy." Information 

Today, vol. 34, no. 1, Jan.-Feb. 2017, p. 6. 

Health Source: Nursing/Academic 

Edition, dmacc.idm.oclc.org/login?url= 

http://search.ebscohost.com/login. aspx?

direct=true&db=hch&AN=120764037&sit

e=ehost-live&scope=site. Accessed 25 Feb. 

2017. 

Riehle, Catherine Fraser, and Merinda Kaye 

Hensley. "What Do Undergraduate 

Students Know about Scholarly 

Communication?: A Mixed Methods 

Study." Libraries and the Academy, vol. 

17, no. 1, Jan. 2017, pp. 145-78. Project 

MUSE, doi:10.13531.pla.2017.0009. 

Accessed 26 Feb. 2017. 

One article, three formats* 
Print.  
Miller, Zeke J. "Winter White House." Time, vol. 

189, nos. 7-8, 27 Feb. 2017, pp. 50-53.  

Database. 
Miller, Zeke J.. "Winter White House." Time, vol. 

189, no. 7/8, 27 Feb. 2017, pp. 50-53. 

Academic Search Premier, http://

dmacc.idm.oclc.org/login?url=http://

search.ebscohost.com/login.aspx?

direct=true&db=aph&AN=121318861&site

=ehost-live&scope=site. Accessed 4 Mar. 

2017.  

Web Site. 
Miller, Zeke J. "At Mar-a-Lago, Donald Trump 

Blends Pleasure, Profit and Politics." Time, 

16 Feb. 2017, time.com/4672984/donald-

trump-mar-a-lago/. Accessed 5 Mar. 2017.  

One article, three formats* 
Please note that the title of the article was different on the Web site than in the print magazine or database. The 
articles themselves are identical. Also, note that the publication date was different. There is a note on the Web 
page that the article was published in the Feb. 27, 2017 issue of Time. MLA advises to use the most relevant 
publication date. In this case, Feb. 16, 2017.  
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Examples: Web Sites 

A general website 
"Overview of Learning Styles." Learning Styles 

Online, Advanogy.com, 2017, learning-

styles-online.com/overview/. Accessed 4 

Mar. 2017. 

"Patricia Bath." Black Inventor Online Museum, 

Adscape International, 26 Nov. 2012, 

blackinventor.com/patricia-bath/. 

Accessed 5 Mar. 2017. 

"South African Government." Republic of South 

Africa, 2017, www.gov.za/. Accessed 4 

Mar. 2017. 

"Types of Learning Disabilities." Learning Disabilities 

Association of America, 2017, ldaamerica.org/

types-of-learning-disabilities/. Accessed 3 

Mar. 2017. 

A blog 
Maloney, Wendi. "Women’s History Month: A 

New Look for a Rich Resource." Library of 

Congress Blog, 1 Mar. 2017, blogs.loc.gov/

loc/. Accessed 5 Mar. 2017.  

A government web site 
McKenzie, Brian. Transit Access and Population 

Change: The Demographic Profiles of Rail-

Accessible Neighborhoods in the 

Washington, DC Area. Research report no. 

SEHSD 2015-023, United States, Census 

Bureau, Dec. 2015, www.census.gov/

content/dam/Census/library/working-

papers/2015/demo/SEHSD-WP2015-

23.pdf. Accessed 5 Mar. 2017. 

CIA World Factbook 

"Eduador." The World Factbook, Central 

Intelligence Agency, 12 Jan. 2017, www.cia.gov/

library/publications/the-world-factbook/geos/

ec.html. Accessed 4 Mar. 2017.  

Occupational Outlook Handbook 
"Registered Nurses." Occupational Outlook 

Handbook, United States, Bureau of Labor 

Statistics, 17 Dec. 2017, www.bls.gov/ooh/

healthcare/registered-nurses.htm. Accessed 

4 Mar. 2017. 
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Examples: Art 

A painting, sculpture or 
photograph viewed in a museum 
Kokoschka, Oskar. Portrait of Mr. and Mrs. John 

Cowles. 1949, Des Moines Art Center.  

Rondinone, Ugo. Moonrise. 2005, Pappajohn 

Sculpture Park.  

Visual art pictured in a book 
Klee, Paul. Anchorage. 1928, Des Moines Art 

Center. An Uncommon Vision: The Des 

Moines Art Center. Neal Benezra et al., Des 

Moines Art Center, p. 156-157. 

Visual art on the web 
Iris Calderhead, Daughter of Former 

Representative Calderhead and Wife of John 

Brisben Walker, of Colorado. Miss 

Calderhead Is a Graduate of the University of 

Kansas, and Vermont. Gave Up Teaching 

Literature in Wichita (Kansas) High School to 

Organize for the National Woman's Party, 

and Was One of the Group Arrested for 

Picketing the White House with Suffrage 

Banners. [ca. 1913-1917 Feb. 24]. Library of 

Congress, www.loc.gov/item/mnwp000110. 

Accessed 3 Mar. 2017. 

Odutola, Toyin Ojih. The Raven. 2016. MoMA, 

Museum of Modern Art, www.moma.org/

collection/works/215367?locale=en. Accessed 

5 Mar. 2017.  
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Examples: Media 

A podcast 
"Chicago Leaders Use Cognitive Behavorial 

Therapy To Combat Violent Crime." Hidden 

Brain, NPR, 28 Feb. 2017, www.npr.org/ 

2017/02/28/517779745/chicago-leaders-use-

cognitive-behavorial-therapy-to-combat-

violent-crime. Accessed 2 Mar. 2017.  

"One Trump Speech Is Not the Economy." 

Marketplace, Minnesota Public Radio,              

1  Mar. 2017, www.apple.com/itunes/

download/?id=201853034. Accessed 6 Mar. 

2017.  

A YouTube video 
“UDL at a Glance.” YouTube, uploaded by CAST, 

17 Mar. 2010, www.youtube.com/watch?

v=pGLTJw0GSxk. Accessed 3 Mar. 2017. 

A published or broadcast 
interview 
Obama, Barack. Interview. By David Axelrod. Full 

Transcript: David Axelrod Interviews 

President Barack Obama for the Axe Files, 

Cable News Network, 26 Dec. 2016, 

www.cnn.com/2016/12/26/politics/axe-files-

obama-transcript/. Accessed 1 Mar. 2017.  

A television or radio program 
Galecki, Johnnie, et al., performers. "The 

Friendship Contraction." Produced by  

Maria Ferrari. The Big Bang Theory, 

created by Chuck Lorre, season 5, episode 

15,  2 Feb. 2012.  
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Netflix, Hulu, etc. 
Manchester By the Sea. Directed by Kenneth 

Lonergan, performances by Casey Affleck, 

Michelle Williams and Kyle Chandler. Amazon 

Studios, 2016. Amazon, https://

www.amazon.com/dp/B01M2BZ6U4/

ref=atv_me_ori_c_h_2_tg18GG1?

_encoding=UTF8&pf_rd_i=originals1&pf_rd

_m=ATVPDKIKX0DER&pf_rd_p=27996608

22&pf_rd_r=VG1R7GTB4KSYKNFDSW24&pf

_rd_s=center-3&pf_rd_t=39901 

Google and the World Brain. Directed by Ben 

Lewis. Polar Star Films, 2013. Kanopy, http://

dmacc.kanopystreaming.com/video/google-

and-world-brain-0 

Examples: Media 
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A personal interview 
Grassley, Charles. Personal Interview. 2 Mar. 

2017.  

Obama, Michelle. Email Interview. 7 Feb. 2017.  

McGregor, Shannon. Telephone Interview. 17 Feb. 

2017. 

A live lecture or presentation 
Thompson, Sara Q., et al. "A Post-Apocalyptic 

Guide to Information Literacy: Survival 

Skills for Information Seeking after 

Graduation." ACRL 2017, 23 Mar. 2017, 

Convention Center, Baltimore, MD. 

Lecture. 

Levy, Simon, adapter. F. Scott Fitzgerald's the 

Great Gatsby. Written by F. Scott 

Fitzgerald, 9 Feb. 2017, Des Moines 

Playhouse. Performance.  

A personal letter or email 
Alberhasky, Matthew. "Using Citations in Your 

Research." Received by the author, 6 Mar. 

2017. 

Examples:  
Personal Communication 

A tweet 
@AmericanU. ‘“Today is another step in a lifelong 

journey of discovery. The most important 

skills. are how to learn and persevere” Dr. 

Hayden.’ Twitter. 21 Dec. 2016, 10:54 a.m. 

twitter.com/AmericanU/status/ 

811645981209071616 

A blog 
Maloney, Wendi. "Women’s History Month: A 

New Look for a Rich Resource." Library of 

Congress Blog, 1 Mar. 2017, blogs.loc.gov/

loc/. Accessed 5 Mar. 2017.  
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Citation Tools 

What is a Citation Tool?  
Citation tools are software programs designed to perform part or all of the tasks involved in creating academic 
citations. Most tools are capable of at least creating your References page at the end of your paper. Some can 
also assist you with your in-text references. A few can even help you manage and organize your resources. 

 

 

 

 

 

 

Should I Use a Citation Tool? 
This is a complicated question. While citation 
tools certainly make the process easier, most 
individuals acknowledge that there is value in 
learning not only the pieces of a written citation, 
but also how it is constructed. 

Many DMACC instructors want their students to 
have the opportunity to learn how to construct a 
written citation. These instructors do not allow 
the use of citation tools, and require that students 
create their own citations.  

Other instructors, particularly in more advanced 
classes, believe that their students have already 
gained this foundational knowledge of how to 
construct a citation. These instructors typically 
see the use of citation tools as somewhat 
equivalent to using a calculator in a higher level 
math class. These instructors are typically “ok” 
with the use of a citation tool, as long as the 
student’s References list is correctly formatted. 

Can My Instructor Tell If I Used a 
Citation Tool? 
This depends a bit upon how the class is 
formatted. If you are simply submitting a final 
draft of a paper, all your instructor will see is 
whether or not your citations are correctly 
formatted. However, not all citation tools are 
particularly accurate, and instructors can always 
do an in-class test of your citation knowledge and 
creation skills. 

How Accurate Are Citation 
Tools? 
This is also a complicated question. Some of the 
citation tools are capable of producing highly 
accurate, detailed citations, provided that the 
information you enter is also accurate. Some 
citation tools are limited in the types and/or 
complexity of the citations they can produce. 
Many citation tools are poorly programmed and 
are incapable of producing accurate citations.  

Ultimately, each student is responsible for the 
work he/she turns in. You should always double 
check your citations for accuracy and 
completeness.  
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Citation Tools 

Which Citation Tool Should I Use? 
There are literally hundreds, maybe thousands, of 
citation tools available. Many are free; some require 
purchase or an on-going fee. Some tools have less 
powerful (and sometimes less accurate) free 
versions, as well as “upgraded” fee-based versions. 
Some instructors will tell you to use their favorite 
citation tool. In the end, you should use the tool 
that best meets your needs. In addition to helping 
you create citations the “old fashioned” way, the 
Library is able to assist you with Noodle Tools. For 
assistance with other citation tools, you will need to 
consult with your instructor or contact the service 
directly.  

Noodle Tools 
Noodle Tools is the preferred citation tool of most 
DMACC researchers. As long as the information 
entered into the Noodle Tools form is accurate, 
the software will produce an accurate citation. 
Noodle Tools asks the user to complete a form for 
each resource. These forms are then converted 
into a properly formatted Works Cited list. While 
the Noodle Tools knowledge base has extensive 
advice and information on how to properly 
construct in-text references, the software itself is 
only capable of producing the Works Cited list, 
which is placed at the end of a paper. 

 

Mendeley 
Mendeley is more of a source manager than a 
citation tool. It offers the most robust citation tool 
currently available. As a result, it is probably best 
suited for advanced users, who are collecting, 
storing and organizing large numbers of 
documents. In addition to producing highly 
accurate, detailed citations, Mendeley offers a 
Microsoft Word plug-in which fully integrates into 
Word 2016. This plug in corrects nearly all the 
errors produced by the Microsoft Word Citation 
Manager. This eliminates the need for corrections. 
Mendeley can also save most citation data directly 
from library databases, Web sites, etc. Mendeley 
can be accessed at http://www.mendeley.com and 
does require the installation of a desktop 
application. Up to 2Gb of information can be 
stored for free. Additional storage is available for 
purchase. 

Microsoft Word Citation Manager 
Some DMACC users prefer the ease of an integrated 
citation tool, like the Microsoft Citation Manager. 
The data form for recording sources can be clunky, 
and Microsoft doesn’t always follow the rules. This 
means that citations need to be corrected before 
submitting them for a grade. Many students find 
this process confusing and stressful.  



Updated: 3/17 36 

 

NoodleTools 

What is NoodleTools?  
NoodleTools is an online tool that can help you format your bibliography page and allows you to save and 
organize the references for books and articles used for your research assignments. It is accessible from 
home and campus through the DMACC library website. For further assistance, contact a DMACC librarian.  

You need to access NoodleTools through 
the DMACC library website. Click on the 
link for “Research Help”. Then, select 
“Citations”. 

A new tab will open on your screen. Click 
on the icon for NoodleTools. 
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NoodleTools 

If you have never used NoodleTools, you 
will need to “Register” to create an 
account.  

 

 

 

 

 

 

 

 

 

 

Complete the registration form, create a 
Personal ID (username) and password. 
You may use anything you would like for 
your username, as long as someone else 
hasn’t already selected it. We 
recommend using your DMACC 
username and password. 

 

 

 

 

 

If you forget your username/
password, please see your 
campus librarian.  
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NoodleTools 

Once you have created your Personal ID, 
you can start entering references by 
creating a new project. Each research 
project you are working on should have 
its own list. Start by clicking on the 
“New Project” button at the top left-
hand side of the page.  

Next, name your project. Select “MLA” 
for the “Citation style” and “Advanced” 
for the “Citation level”. Click 
“Submit” at the bottom of the box to 
get started.  

You may name your project 
anything you like, but we 
recommend that you include 
the topic of your project, the 
course and semester. E.g. 
Mystery Cozies & American Lit 
Comp II Spring 2017. 
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NoodleTools 

The next screen is called the Dashboard. 
Here you can work on many aspects of 
your project: your thesis statement, your 
research question(s). You can also share 
your project with a teacher or librarian to 
receive assistance and/or feedback.  

You can set up and maintain a “To Do” 
list of tasks you still need to complete for 
your project. You can use NoodleTools to 
create digital notecards and your outline.  

You will primarily use NoodleTools to 
create your Reference list for your 
project. You may begin by clicking 
“Sources” at the top of the screen. 

 

 

 

 

Once you have clicked on 
“Sources”, you are ready to begin 
entering the information for each of your 
sources. 

Create a citation for each source by 
clicking “Create New Citation” in the 
upper left-hand corner. 

While NoodleTools provides a 
link to Google Docs, we 
recommend that you use 
Microsoft Word to write your 
paper. Word is available on all 
DMACC computers. Students 
can also access Word Online for 
free through their Webmail.  
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NoodleTools 

First, select where you located your 
resource. For most DMACC students, 
this will usually be either “Database” or 
“Website”. 

 

 

 

Then, select what the item is. 
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NoodleTools 

Complete the form with the available 
information for your resource. If you 
decide you have selected the incorrect 
resource type, you may make changes 
from the drop down boxes at the top of 
the screen. 

 

As you select each text box, 
NoodleTools will give you 
instructions for the correct 
entry of your data. If you 
make a mistake, NoodleTools 
will display an exclamation 
point inside of a yellow 
triangle. 
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NoodleTools 

Once you have clicked on “Submit” to 
complete a resource, NoodleTools will 
return you to the main Works Cited screen. 
To enter another resource, simply select the 
resource type from the drop down and 
begin the process again. 

Complete the form with the available 
information for your resource. If you decide 
you have selected the incorrect resource 
type, you may make changes from the drop 
down boxes at the top of the screen. 

After you have entered all of your sources 
and completed your paper, review each of 
your citations on the main Works Cited 
page for errors. You can edit your citations 
by clicking the “Options” button on the 
right-hand side of the screen. 
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NoodleTools 

Finished? Now print your References Page 

 
 

To print your References page, click the 
“Print/Export” button and then 
select “Print/Export to Word” 

  

 

 

 

 

 

 

 

 

Once you see the pop-up for Microsoft 
Word, click “Ok”. Your References 
page will open in a new Microsoft Word 
window. 
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NoodleTools 

NoodleTools will always open your Ref-
erences in Times New Roman, 12pt font. 
Double check and make sure that the 
font matches what’s on the rest of your 
paper. Also, be sure to add a header with 
your name and the correct page number. 
Please see a DMACC librarian if you 
need help with getting the correct page 
number added. 

Since NoodleTools saves your 
work to their server, and keeps 
track of any changes to your list, 
we recommend that you wait and 
print your Works Cited at the 
very end of your project. This will 
help eliminate confusion and 
mistakes between what you may 
have saved and what 
NoodleTools has saved.  
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